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Procesamiento de datos y mas..

edicion vectorial

introduccion al procesamiento
espacial avanzado
Plug-ins

Processing Modeler

conexion con GRASS GISy otros
programas...




la edicion vectorial en QGIS es
tremendamente flexible e
inigualable
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Ejercicio 3 - edicion vectorial

e Objetivo
o Aprender las herramientas basicas de edicion de una capa
vectorial
e Procedimiento
o cargar ortofotografia de un lugar
o crear un archivo de datos
o editar un elemento espacial de interés
e.g. cubiertas del terreno
o salvar los cambios en un archivo

o *ejercicio3 - QGIS - o x

Project Edit View Layer Settings Plugins Vector Raster Database Processing Help

DPEBRRX 0 PP HPPLALABEIR 06 K- 8- LEE#Za-
BV AW N [/BRR-ZG*DBoo =a@uasss A 0B ¥

Layers ®

« @ ® T &R AD
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New GeoPackage Layer

Database {S/ejercicios_zm9/ejercici03/layers_ejercio3.gpkg a@ \74
Table name i coberturas |
C r r n n Geometry type (' Polygon \'
ea u a u eva I Include Z dimension = Include M values
t r : l Project CRS: EPSG:25830 - ETRS89 / UTM zone 301 ¥ [ ;%
Capa vectoria et
Name [}nombre
e Crear nuevacapa Type | -]

Maximum length |

- Geopackage, Shapefile, SpatialLite o 1 add toFields it

archivo temporal (Scratch Layer) S
- punto/linea/poligono (otros) };ame e Length
- configurar campos tipo text

- definir archivo
e Editar

~. Remove Field

p Advanced Options

Help Cancel ‘ OK \

o ejercicio3 - QGIS

Project Edit View m Settings Plugins Vector Raster Database Processing Hel

3 =] (=] @ V! DataSource Manager ctrl+l L 4 o A e : e =

: L I ? [ 3%
D - | Create Layer Eb @ * 2

Add Layer

i Q @ VS /f) Embed Layers and Groups...

Layers Add from Layer Definition File...
« @ ® T & v |5 copystyle
v O ® Vuelo Nacional I Paste Style

Returned legend inj
I Copy Layer
v O @ Vuelo americal Yy

Paste Layer/Group
v O B SIGPAC (19974
b = % PNOA

zsl’>ezn

/. New SpatiaLite Layer...
# New Temporary Scratch Layer...

Open Attribute Table F6
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Clean up all the mess
on my desk

Preparar edicion vectorial: .

Eat those fantastic
chocolate cakes

ajuste y topologia

e Establecer parametros de edicidn

- Tolerancia de ajuste: Project > Snapping Options
— Edicion “topolégica” — lineas comunes en poligonos
- Restringir intersecciones: Avoid intersections

e Manejar lavista — ratén, cursores o herramientas

Project Snapping Settings

@ ::33 AllLayerSvj % Vertex~ 1712 o opx " v TopologicalEditingl “_ Snapping on Intersection

Project Snapping Settings x

@ ‘% Advanced Configuration-“ * Topological Editing

. Snapping on Intersection

j Layer Type ‘Tolerance | Units Avoid intersection l
= | ifn3_huesca_ vertex 12 pixels
= | municipios_4258_es241 vertex 12 pixels

= 7| coberturas vertex 12 pixels
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FSSS

Herramientas de edicion basica

e Comenzar/Parar/Salvar edicion
- Se puede hacer en varias capas a la vez
e Digitalizacidon de nuevos elementos
1 Puntos, lineas o poligonos
tras crear sale formulario de atributos. (opc.)

2 Editar vértices
3 Editar atributos de elementos seleccionados
4 Eliminar/Cortar/Copiar/Pegar elementos
5 Deshacer/Rehacer edicién
landcover basadelamora - Feature Attributes
¥ 12 3 4 5 -
- — id 1 @
: % =9 : = =
"[ﬂ E % ﬁ M V// m s B ‘[j 43 cover type water a
cover cod 1 &
ndcover basadelamora Iabal lamina de agual a
v noa_basadelamoral
Cancel OK
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Herramientas de edicion avanzada 1

Introduccion alos SIG libres: QGIS 3

FSSS

1 2 3 4a 5a4b 4c 5b 6 7 8 9 10 11

NE-TOIREARPLCRRCEC-

1 Mover [y copiar] elementos

2 Rotar elemento

3 Simplificar

4 Anadir/rellenar/eliminar orificio
5 Anadir/eliminar parte

6 Redisenar elemento

7 Curvas paralelas

8 Cortar elementos o partes
9 Unir elementos seleccionados
10 Unir atributos de elementos
seleccionados
11 Rotar simbolo
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'y

Herramientas de edicion avanzada 2

Permite editar con precision

Incluir coordenadas, angulos y distancias: Coordinate Geometry (CAD)

Tl

Advanced Digitizing

B &3] >

d|531,648419

a|-153,427751

x | 787889,237752

@ y ‘ 4721317,647541
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Salvar ediciones

e Guardar ediciones
e Dejar de editary guardar o descartar cambios
e Tener en cuentalos elementos simplesy
multiples
(multipart / single part)
e Ser cuidadoso con las uniones de elementos

H-\/BR&R-Z T <2 B 60

B Guardar para la capa(s) seleccionada(s)
& Revertir las capas seleccionadas

@ Cancelar para la capa(s) seleccionada(s)
B Guardar para todas las capas

& Revertir todas las capas

@ Cancelar para todas las capas

4 Zoom to Layer
4 Zoom to Selection
“2 show in Overview
"~ Show Feature Count
Copy Layer
Rename Layer

! Duplicate Layer
1 Remove Layer...

Move to Top

;f—,‘_g “l -I l I'l

|7 Toggle Editing

I} save Layer Edits

# Current Edits 4

I:;h-e.-

Set Layer Scale Visibility...
Set CRS >

Export

Styles

Properties...
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Salvar ediciones

-/ BB~ 7

4~ Zoom to Layer
4 Zoom to Selection
“2 Show in Overview
=l Show Feature Count
Copy Layer
Rename Layer

! Duplicate Layer
Ll Remove Layer...

Move to Top

|7 ?oggle Editing
I} save Layer Edits

Introduccion alos SIG libres: QGIS 3

Guardar ediciones

Dejar de editar y guardar o
descartar cambios

Tener en cuenta los elementos
simples y multiples

(multipart / single part)

Ser cuidadoso con las uniones
de elementos

Configurar Topologia

., Current Edits
Filter...

Set Layer Scale Visibility...
Set CRS

Export

Styles
Properties...

=) Save for Selected Layer(s)

s Rollback for Selected Layer(s)
4 cancel for Selected Layer(s)

» [} save for All Layers
p . Rollback for All Layers

4 cancel for All Layers




Mas herramientas de
procesado espacial de datos



Herramientas de

procesamiento vectorial del menu
principal
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Procesamiento vectorial basico

Jgins Raster Database Processing

g} ﬁ Geoprocessing Tools > UE )
Geometry Tools | 2
g ag Analysis Tools 4 o
Data Management Tools 4 °
Research Tools 4
.I °
o
A
2* Collect Geometries... B
" Extract Vertices...
& Multipart to Singleparts... " Buffer...
== simplify... # clip...
' Check Validity... @ convex Hull...
@ Delaunay Triangulation... & Difference...
4 Densify by Count... @ Dissolve...
== Add Geometry Attributes... %' Intersection...
<7 Lines to Polygons... ¥ symmetrical Difference...
¢ Polygons to Lines... @ Union...
& Voronoi Polygons... # Eliminate Selected Polygons...

desde el menu vectorial

Herramientas analisis cientifico
Geoprocesamiento espacial (B)
Transformaciones geomeétricas (A)
Herramientas de analisis (C)

«* Line Intersections...

23 Mean Coordinate(s)...

2. Basic Statistics for Fields...

“3 Count Points in Polygon...

B Distance Matrix...

% List Unique Values...

# Nearest Neighbour Analysis...
#% sum Line Lengths...
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Procesamiento vectorial (1)

e Herramientas de analisis

Matriz de distancia

Suma de distancias
Contar puntos contenidos
en poligonos

Enumerar valores Unicos
Estadisticas basicas
Analisis del vecino mas
proximo

Coordenada media
Intersecciones

Introduccion alos SIG libres: QGIS 3

W Distance Matrix...

#8 Sum Line Lengths...

#3 Points in Polygon...

List Unigque Values...

BE Basic Statistics...

¥ Nearest Neighbour Analysis...
** Mean Coordinate(s)...

¥ Line Intersections...
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Procesionamiento vectorial (2)

@ Random Selection...

¢ Herramlentas Clentlﬁcas ‘@ Random Selection Within Subsets...
— Seleccion aleatoria i% Random Points...
— Elementos regulares Regular Points...

. G dinate Capt > i
~ Seleccionar por lugar SueE PR FycetarCng..
Poli d t .. OpenStreetMap *  %r Select by Location...
OlIgono de extension 4 Analysis Tools » B, polygon from Layer Extent...
. L R h Tool >
e Geoprocesamiento e
E | £ Geoprocessing Tools » | Q Convex Hull(s)...
- ,nvo ventes @ Geometry Tools » | Buffer(s)...
- Areas de mﬂuenCIa 8 Data Management Tools » |[® Intersect...
- Interseccién/Unidn #® Union...
- Diferencia simétrica K Symmetrical Difference...
- Recorte/Diferencia @ Clip...
. &' Difference...
- Disolver .
#® Dissolve...

#® Eliminate Sliver Polygons...
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Procesionamiento vectorial (3)

e Herramientas de geometria

Centroides

Triangulacion / Poligonos Voronoi
Simplificacion

Multiparte / Partes sencillas
Poligono — Lineas — Nodos

e Herramienta de gestion de datos

Definir proyeccion

Unir atributos por localizacion
Dividir capa vectorial (por atributo)
Combinar archivos: Merge

Crear indice espacial

Introduccion alos SIG libres: QGIS 3

’a Check Geometry Validity...

’a Export/Add Geometry Columns...

@ Polygon Centroids...

® Delaunay Triangulation...

B \Voronoi Polygons...
Simplify Geometries...
Densify Geometries...

$° Multipart to Singleparts...

$° Singleparts to Multipart...

? Polygons to Lines...

(” Lines to Polygons...

V" Extract Nodes...

‘&, Define Current Projection...
B Join Attributes by Location...
V" Split Vector Layer...

By Merge Shapefiles to One...

Create Spatial Index...



Herramientas de

procesamiento raster del menu
principal
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Herramientas procesamiento raster

*ejercicio3 - QGIS

Plugins Vector Database

Processing Help

j @ p ﬁ d1§Ra.sterCalculator...

Align Rasters...
Analysis
Projections
Miscellaneous
Extraction
Conversion

vVVvVevvwYyw

g 3 [

i Fill nodata...
. Grid (Moving Average)...
i Grid (Data Metrics)...

I Grid (Inverse Distance to a Power)...

. Grid (Nearest Neighbor)...
aw Hillshade...
%] Near Black...

. ' Proximity (Raster Distance)...

i Roughness...
wu Sieve...

an Slope...

i Topographic Position Index (TPI)...
o Terrain Ruggedness Index (TRI)...

Introduccion alos SIG libres: QGIS 3

Desde el menu Raster
Algebra de mapas

Alinear capas rasters
Cambios de proyeccioén
Cambios de formato
Extraccion (isolineas vy clip)
Otras...

‘. Assign Projection...
C% Extract PrOJectlon

% clip Raster by Extent...
% clip Raster by Mask Layer...

= PCT to RGB..

“ Polygonize (Raster to Vector)...
‘) Rasterize (Vector to Raster)...
“_ RGBto PCT...

~ Translate (Convert Format)...




Extensiones
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Ejercicio 4 - Manejar plug-ins

e Objetivo
o Instalar extensiones que amplian las capacidades basicas de QGIS y
generar un ejemplo de datos o visionado con estas herramientas

e Procedimiento
o Instalar las extensiones

2]
= QGIS2Threejs th
m  QGIS2Web re e -J S
o Correr las extensiones
m Rellenarlas opciones

para generar web HTML5 \./ Open LayerS

Leaflet o
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Instalar extensiones (1)

e Plugins > Manejar e instalar... e Incluir extensiones en

- i evaluacion
e Habilitar extensiones

e Anadir extensiones:
Openlayers, Table Manager,
Pugio Al 525 Point Sampling Tools,

e Cargar extensiones de Python

| & mmqgi & |
L]
r o - mmagis | ; -] MMQGIS kOSM
F ] Installed mmqg|s Q ’ UIC eoo
Al A collection of QGIS vector layer
% Upgradeable operation plugins
- Install from MMQGIS is a set of Python plugins for manipulating
ZIP vector map layers in Quantum GIS: CSV TS
input/output/join, geocoding, geometry conversion, *ejercicio3 - QGIS
* Settings buffering, hub analysis, simplification, column Layer Settings l;mm Vector Raster Database Processing MMQGIS Help
modification, and simple animation. MMQGIS provides = = = ————— == T
/| an alternative to the Processing toolbox, with verbose @ o/ . @ ' Manage and Install Plugins... i -~ . Qz o v Qg v
progress reporting, an intuitive user interface, direct ma -~ N a h l 1+Al N
shapefile/CSV-file access, and some additional ) - Python Console Ctri+Alt+P
capabilities missing from other plugin sets. I 'ﬁ ; Gl * @ OSM Tools »
77777 777% 252 rating vote(s), 653556 downloads i::r;l‘sglnsp;re :I:atastral e :
-Downloader

@m®

Category Vector

Tags merge,animate,delete,sort,vector v|f & A [l
| I D] ‘

Upgrade All | Uninstall Plugin! Reinstall plugin \izsa_eszu

Help Close #al (1981-1986) :
Returned legend image is flawed [UR

v O W Vuelo americano (Serie B, 19...
v O W SIGPAC (1997-2003)

b = = PNOA
< E %" OpenStreetMap
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Hay muchisimas... para todos los gustos:
http://plugins.ggis.org/ | https://gitlab.com/msevilla00/

Introduccion alos SIG libres: QGIS 3

T:B Installed

-

Not installed

ﬁ Settings

Search

B Affine Transformations

v E autoSaver
v m AutoTrace
v —:!:- Coordinate Capture
v DB Manager
tﬁh Dxf2Shp Converter
ﬁ eVis
v o fTools
v B GdalTools
[ Geometry Checker
i Geometry Snapper
v j:t Georeferencer GDAL
v @ Globe
v ®2 GPs Tools
v @) GRASS 7
v [32 Group stats
Heatmap
“ Interpolation plugin
v of Layer Board

v & Layer Combinations

@ Merge shapes

v ©% MetaSearch Catalogue Client

v ©% MetaSearch Catalogue Client
v| B mmqgis
v % Numerical Vertex Edit
\ OfflineEditing
v . OpenlLayers Plugin
% Oracle Spatial GeoRaster
v i OSMDownloader
v ;@ OSMEditorRemoteControl
v ﬁ Point sampling tool
v 8 Processing
v @, Profile tool
v | =] QConsolidate
v i qgis2leaf
v ¥ Qgis2threejs
v 5¥ qgis2web
v gb QSpatiaLite
&g Qsphere
v & QuickMapServices
vz QuickOSM

v @ Raster Terrain Analysis plugin

v Q Point sampling tool
v & Processing
v @, Profile tool
v | =] QConsolidate
v i qgis2leaf
v ¥ Qgis2threejs
v 5F qgis2web
v gb QSpatiaLite
&g, Qsphere
v &3 QuickMapServices
vz QuickOSM
v @ Raster Terrain Analysis plugin
v - Rectangles Ovals Digitizing
. Road graph plugin
\2 spatial Query Plugin
v g Table Manager
v e Tile Map Scale Plugin
v W Topology Checker

v B XyTools

v e kil


http://plugins.qgis.org/plugins/
https://gitlab.com/msevilla00/qgis_files/blob/master/QGIS_plugins_notes.md
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Ejemplos con Plugins

o MMQGIS
o Completa coleccion de herramientas
e OpenlLayers
o Cargar imagenes de satélite desde Google Maps u otras fuentes <-- tener
en cuenta CopyRights
e QuickOSM
o Descargade datos de OpenStreetMap
o Usarla APl OverPassTurbo
e QGIS2Threejs
o Crearvistaen 3D
o Cargar MDE + Ortofoto o imagenes de satélite
o QGIS2web

o Montar un pequeno proyecto web



Plugins | All (665)

% All Search |threejs a

. J is2threejs = 3
E Installed = Qg ; Qgis2threejs \ 4
2% Not installed

3D visualization powered by WebGL technology and three.js
ﬁ Settings JavaScript library

Qgis2threejs plugin exports terrain data, map canvas image and vector data to your
web browser. You can view exported 3D objects on web browser which supports

IFI Installed v ¥ qgis2web

qgis2web

2% Not installed
Export to an OpenlLayers/Leaflet webmap

* Settings qgis2web generates a web map from your current QGIS project, either as
OpenLayers or Leaflet. It replicates as many aspects of the project as it can,

2 -

2% Not installed

A collection of QGIS vector layer operation plugins

# Settings MMQGIS is a set of Python plugins for manipulating vector map layers in Quantum
GIS: CSV input/output/join, geocoding, geometry conversion, buffering, hub

I-f'.!l Installed vz QuickOSM V
This plugin is trusted

QuickOSM E

QuickOSM allows you to work quickly with OSM datas in QGIS
thanks to Overpass API.

7% Not installed

# Settings

Upgrade all Uninstall plugin Reinstall plugin

Close
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Introduccioén a los SIG libres- OGIS 3
e WE

% 4

Generar vista web 2d
e Desde botén de QGIS2web

- £
o e NG

Export to web map

Export ' Settings Help

| ¥ Layers and Groups
> O ifn322_epsg25830

> O eudem_25830 clipsqr_es241_contour_100m

Add address search @ | =

'
Pico del

> v [ ifn322_epsg25830_clip_municipios_ordesa1 ‘ ™ Pico di ifn322_epsg25830_clip_municipios_ordesal
R ol T =1 dSalaror
>0 mun!c!p!os_25830_ordesa1 | Ve PNOA
- B | [N eeuansiciniasr AJLCO Ac2A1 ‘\ t_ ) %1
v Data export / th?élrde-?‘ o P P 252
Mallo 7 e A ¢ e 7 ]
Exporter Export to folder 5| |.. 22samiy AR ST i
h - oA N J A
Min zoom level 13 = e N e 4
: “” Picod -
Restrict to extent i Ny e—i
V Appearance :

¢ Openlayers Leaflet

[& Update preview

m—— OSM B&W

|| Stamen Toner
[l FalalV.Eal=

Add layers list Expanded s E .
Geolocate user ' jgis2uch @ © OpenStrectMap contributors.
Highlight on hover v

Lavc1 ¥a| \_:_I :‘IUIIC




Export to web map

Export | Settings Help

Vv Layers and Groups ' : .’, _ especlel:
v / O teselas forestales ' superficte: 11330.459
Visible i J 2
Popup fields : i & ‘:‘ teselas forestales
especie1l |header label N 4 N : Ortofoto IGN PNOA
superficie |inline label 3 | Mapa topogrifico IGN
v v [0 Ortofoto IGN PNOA
Visible v
v & O Mapa topografico IGN
Visible

V Appearance
Add address search

Add layers list

Geolocate user

Highlight on hover

Layer search None

Match project CRS

Measure tool Metric 5

Show popups on hover R\ ¢ 2\ \ B ..o @ © oot i

Template full-screen . ‘ i —
.

= - |OSM B&W ‘
e Openlayers Leaflet | [& Update preview | QExport Stamen Toner I

NCAA NDC .




Mozilla Firefox

—

& teselas forestales

Ortofoto IGN PNOA
Mapa topografico IGN

qgis2web & © OpenStreetMap contributors.



https://msevilla00.github.io/tmp/openlayers/
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Natide W ‘

Generar una vista web 3D

e Desde el boton de QGIS2Threejs configurar vista 3D

N

Template file | 3DViewer.html

World
Controls

DEM Layer eudem_25830 clipsqr_es241_bilinear

i Resampling
» Additional DEM ~® Simple

Point
shing 393 x 230

> Polygon Grid spacing: X |35.0154902074 | Y |34.9824502021

Surroundings Size 5 " Roughening 4

Advanced (quad tree)

Display type
* Map canvas image

Layer image 0 layer selected [Select layer(s)-- |

Image file Browse...| _

Output HTML file path

' ‘Uemporary file] ’ Browse...

02 | _Run || Close Help




o 20170406133620 - Mozilla Firefox

20170406133620 L+

€ ® @ | https://msevilla00.github.io/tmp/qgis2threejs/ c ¥ O : of ® 2B

https://msevilla0@.github.io/tmp/qgis2threejs/



https://msevilla00.github.io/tmp/qgis2threejs/

Processing Toolbox
Processing Modeler
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Introduccion alos SIG libres: QGIS 3

Ejercicio 5 - Primeros pasos con Processing

e Objetivo
O
y creacion de un modelo sencillo.
e Procedimiento
o Activar el panel de Processing Toolbox
o Navegar por sus herramientas
o Correr alguna herramienta
O

o Processing Modeler

Aprender a manejar y correr los médulos de andlisis de Processing Toolbox

Generar un modelo sencillo en Processing Toolbox

- B B X :

CEERBBR AL PN Kk B P 7
Model properties [ [a]
Name |zonal stats \ & Zona 2
Group |personal \ In *

‘-ﬁ- Zonal statistics ‘
Algorithms P -
& i : | & Raster i:i Zonal statistics
» ) Network analysis (&
» (@ Raster analysis
» ) Racter Ferrain analucic
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Processing Toolbox

e Lanzamiento de algoritmos de
| e, 0 B
(@ seareine | procesamiento espacial

+ (O Recently used

@ Cartography ® CreaCién de MOdEIOS
@ Database p .
@ File tools e Busquedade opciones
@ Graphics . o 7
Wine st e Personalizacion
2 Layer tools

- @ Network analysis e Tareas Avanzadas

@ Raster terrain analysis
@ Raster tools
@ Vector analysis
@ Vector creation
@ Vector general
@ Vector geometry
@ Vector overlay
@ Vector selection
@ Vector table

+ @ GDAL

+ @ GRASS

T M ANAAAA~

| Rotation | 0.0° 0| & Render @ epsc3ss7 Q@ I

A Raster analysis
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Ejemplo de algoritmo desde Processing

Zonal statistics

0

rs @®

Multiple selection Processing Toolbox

oS GR-R 8- 35 ) v/ Count oK 22081518
1 5 zona analisis | Sihe Vi Searchy::
7/ Vectorized 2 m::?an @cancel YO hecently used
¥ raster.xyz std. dev. Select All » @ cartography
763 Min N fect » @ Database
802 Max ClearSelection » @ File tools
/| ¥ rasterasc Range i » @ Graphics
e Minority Toggle Selection - P .
el » @ Interpolation
802 Ma)prlty(mode) » @ Layer tools
®® 7x7_grid_raster xg:::rtxyce » @ Network analysis
W 763 All ~ (@ Raster analysis
802 ) # Raster calculator
® raster ¥ Raster layer statistics
| | 63 ¥ Raster layer unique values report
80 # Reclassify by layer
¥ Reclassify by table

Parameters | Log
Raster layer

& 7x7_grid_raster [EPSG:32630]
Raster band

VBand 1 (Gray)

9 Vector layer containing zones

# sample raster values
# Zonal histogram

Zonal statistics

» (@ Raster terrain analysis
» (@ Raster tools

» @ Vector analysis

» @ Vector creation

» @ Vector general

» @ Vector geometry

» @ Vector overlay
»
»
»
»
»
»

Fav| || zona_analisis [EPSG:32630] & ve el
v [ i 2 Vector selection
e ;:o Output column prefix O vectortable
3 Hof | = @ GDAL
5/ Statistics to calculate & GRASS
| & SAGA
' D # Scripts
L ]
|
v B
v [
v
B 0%
v B — =
v O ©OHelp Run as Batch Process... % Close
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Processing Modeler

o Processing modeler - o x
BRR &M &2 2
merg @ RGBimage testing

v & GDAL/OGR

v [GDAL] Miscellaneous ‘ - PR Output raster type
& Merge " banda roja 4 Layer stack
vy QGIS geoalgorithms : ;\ Ger pseudocolor tab...
v Vector general tools H” banda azul 2 —_——"Input layers
# Merge vector layers ‘ e i & :
v & SAGA (2.2.6) “#’ banda verde ;21 & Merge ;;‘
v Vector general tools i out =] o
& Merge vector layers Merged® "’ archivo RGB

Inputs Algorithms

e Generar un flujo de trabajo con algoritmos de procesamiento: internos de QGIS,
GDAL/OGR, GRASS GIS, SAGA, LASTools y mucho mas

e [Exportar a Python]
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Ejemplo sencillo de modelo

o Processing Modeler - o x

TBREREBE AL AN Binlx B P

Model properties a

&%

Name zonal stats | ¢ Zona

Group personal In +

4 Zonal statistics

Algorithms
Q ) & Raster

Out =
Zonal statistics

@ Network analysis =
@ Raster analysis

( Raster terrain analysis

( Raster tools

@ Vector analysis

@ Vector creation |
@ Vector general o Vector % Intersection 3|
( Vector geometry sos
@ Vector overlay Out *
@ Vector selection

(& Vector table

d GDAL

& GRASS

*: Models

» [ ¢ Project models

» & SAGA

» @ Scripts

In +

v v vV VvV VvV VvV VvV Vv VvYVvYTVYYVwVYvyw |

Inputs | Algorithms P »




GRASS GIS
integrado en Processing Toolbox y
a traves de plug-in propio
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GRASS en QGIS: Processing y Plug-in

Processing Toolbox GRASS Tools: p_iberica/pruebas ®

(e @y @ 2 e
Modules | Region | [G] Close mapset

Q Search...

# @ Raster analysis i Filter
@ Raster terrain analysis - GRASS MODULES
Q@ Raster tools il
@ Vector analysis GRASS shell
@ Vector creation
@ Vector general
@ Vector geometry
@ Vector overlay
@ Vector selection
Q@ Vector table
#m GDAL

Create new GRASS location and transfer data into it
File management

Region settings

Projection management

Raster
Vector
Imagery
Temporal
# Imagery (i.*) Database
# Miscellaneous (m.*) Convert coordinates
Raster (r.*) Help
Vector (v.*)
Visualization(NVIZ)
@ nviz
+ % Models
|+ & SAGA
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Sistema de archivos de GRASS

Introduccion alos SIG libres: QGIS 3

e GRASS GIS database directory / Directorio de proyectos
o Donde podemos centralizar los proyectos de GRASS (Locations)
o Puede ser la carpeta del propio proyecto de trabajo

e Location/Proyecto

@)

Toda la informacion de este directorio estara en el mismo sistema de
coordenadas

e Mapset/Conjunto de mapas

o Contiene los subapartados del proyecto
o Pueden estructurarse por tareas del proyecto o por usuarios
o existe siempre el mapset PERMANENT como subconjunto final

QE}
/l

@@@MM@@ m@
& '@:u;@g @)

E.é [JE 2D view [

BRISBECPPHRL Ll

Display 1 ‘

4 bx‘

GRASS GIS Raster Map Calculator

Operators Output

Name for new raster map to create

Operands

&&& ] Insert mapcalc function
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Analisis vectorial con GRASS

https://grass.osgeo.org/grass74/manuals/vectorintro.html

GRASS GIS Manual: Vector data processing in GRASS GIS - Chromium

¥ GRASS GIS Manual: Vect X

c 2 C @ https://grass.osgeo.org/grass74/manuals/vectorintro.html Q v O

Table of
contents

Vector data processing in GRASS GIS

Vector maps in general

A "vector map" is a data layer consisting of a number of sparse features in
geographic space. These might be data points (drill sites), lines (roads),
polygons (park boundary), volumes (3D CAD structure), or some
combination of all these. Typically each feature in the map will be tied to a
set of attribute layers stored in a database (road names, site ID, geologic
type, etc.). As a general rule these can exist in 2D or 3D space and are
independent of the GIS's computation region.



https://grass.osgeo.org/grass74/manuals/vectorintro.html
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Analisis raster con GRASS

https://grass.osgeo.org/grass74/manuals/rasterintro.html

GRASS GIS Manual: Raster data processing in GRASS GIS - Chromium

¥ GRASS GIS Manual: Rast X

< > C @ https://grass.osgeo.org/grass74/manuals/rasterintro.html Qa v 6

Table of
contents

Raster data processing in GRASS GIS

Raster maps in general

A "raster map" is a data layer consisting of a gridded array of cells. It has a
certain number of rows and columns, with a data point (or null value
indicator) in each cell. These may exist as a 2D grid or as a 3D cube made
up of many smaller cubes, i.e. a stack of 2D grids.

The geographic boundaries of the raster map are described by the north,
south, east, and west fields. These values describe the lines which bound
the map at its edges. These lines do NOT pass through the center of the

PEEDNTY ) |TRENEYE | MR, ) Y Tieer R ) TGt [ g ST SRR ERpEEpeesnty . gt D : L5000 R YT G ¢ D ey



https://grass.osgeo.org/grass74/manuals/rasterintro.html
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Teledeteccion con GRASS

https://grass.osgeo.org/grass74/manuals/imageryintro.html

GRASS GIS Manual: Image processing in GRASS GIS - Chromium

¥ GRASS GIS Manual: Ima: X

< > C @& https://grass.osgeo.org/grass74/manuals/imageryintro.htm| Q v O

(Table of
contents

Image processing in GRASS GIS

Image processing in general
Digital numbers and physical values (reflection/radiance-at-sensor):

Satellite imagery is commonly stored in Digital Numbers (DN) for minimizing
the storage volume, i.e. the originally sampled analog physical value (color,
temperature, etc) is stored a discrete representation in 8-16 bits. For
example, Landsat data are stored in 8bit values (i.e., ranging from 0 to 255);
other satellite data may be stored in 10 or 16 bits. Having data stored in DN,
it implies that these data are not yet the observed ground reality. Such data

PN, | ARl v T DT R VT R TT  A Lo EY {  S (n T & S S, p e e 4 | TR | LN



https://grass.osgeo.org/grass74/manuals/imageryintro.html

Python + QGIS: PyQGIS
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PyQGiIS --> Scripting en QGIS con Python

:Por qué montar scripts de python con programas privativos
si puedo hacer lo mismo con programas libres?

http://docs.qgis.org/testing/en/docs/pyggis developer cookbook/

€ ) ® | docs.qgis.org/testing/en/docs/pyqais_developer_cookbook/ Extending QGIS 3 with
Python 3

DOCUMENTATION QGIS TESTING h

» previous | next
TABLE OF CONTENTS

USER GUIDE/MANUAL (QGIS TESTING!)

[ : PyQGIS Developer Cookbook

PYQGIS COOKBOOK (QGIS TESTING!)

e Introduction
Introduction © Run Python code when QGIS starts

Loading Projects © Python Console

o Python Plugins

© Python Applications
¢ Loading Projects

Loading Layers
Using Raster Layers

Using Vector Layers ® Loading Layers
© Vector Layers
© Raster Layers

Geometry Handling

...................


http://docs.qgis.org/testing/en/docs/pyqgis_developer_cookbook/

Mas ayuda y documentacion...
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Comunidad de usuarios y desarrolladores de
QGIS es muy dinamica y entusiasta: unete!

' Lista de correo de QGIS en espanol en lists.osgeo.org (puedes verla a
modo de foro en nabble.com) o consultar otras listas de QGIS en OSGeo

& Grupos de usuarios de QGIS (habla hispana): Colombia: ggisusers.co ;
Meéxico: ggis.mx ; Peru: ggis.pe; Espana: ggis.es

i)Y Twitter (grupos usuarios): @ggismexico; @ggises

% Grupo de mensajeria instantanea en Telegram: http://t.me/qgis es

Bl Documentacién creciente de QGIS en web del proyecto:
https://agis.org/es/docs/index.html

@ Asociacion de usuarios de QGIS en Espana: mas info en QGIS.es


https://lists.osgeo.org/cgi-bin/mailman/listinfo/qgis-es
http://osgeo-org.1560.x6.nabble.com/QGIS-es-f5092059.html
https://lists.osgeo.org/listinfo
http://qgisusers.co
http://qgis.mx
http://qgis.pe
http://qgis.es
https://twitter.com/qgismexico
https://twitter.com/qgises
http://t.me/qgis_es
https://qgis.org/es/docs/index.html
http://qgis.es
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